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CBSE | DEPARTMENT OF SKILL EDUCATION 
DESIGN THINKING & INNOVATION (SUBJECT CODE - 848) 

  MARKING SCHEME FOR CLASS XII (SESSION 2024-2025)  

Max. Time: 2 Hours Max. Marks: 50 

General Instructions: 

1. Please read the instructions carefully. 

2. This Question Paper consists of 22 questions in two sections – Section A & Section B. 

3. Section A has Objective type questions whereas Section B contains Subjective type questions. 

4. Out of the given (5 + 17 =) 22 questions, a candidate has to answer (5 + 10 =) 15 questions in the 
allotted (maximum) time of 2 hours. 

5. All questions of a particular section must be attempted in the correct order. 

6. SECTION A - OBJECTIVE TYPE QUESTIONS (24 MARKS): 

i. This section has 05 questions. 

ii. There is no negative marking. 
iii. Do as per the instructions given. 

iv. Marks allotted are mentioned against each question/part. 

7. SECTION B – SUBJECTIVE TYPE QUESTIONS (26 MARKS): 

i. This section contains 17 questions. 

ii. A candidate has to do 10 questions. 
iii. Do as per the instructions given. 
iv. Marks allotted are mentioned against each question/part. 

 
SECTION A: OBJECTIVE TYPE QUESTIONS 

 

Q. 
No. 

 
QUESTION 

Source Material 
(NCERT/PSSCIVE/ 

CBSE Study Material) 

Unit/ 
Chap. 

No. 

Page no. 
of source 
material 

 
Marks 

Q. 1 Answer any 4 out of the given 6 questions on Employability Skills (1 x 4 = 4 marks) 

i.  d) All of the above    1 

ii.  b) An opportunity    1 

iii.  b) CTRL + A    1 

iv.  d) All of the above    1 

v.  d) Language barriers    1 

vi. c) To address environmental challenges   
sustainably 

   1 

Q. 2 Answer any 5 out of the given 6 questions (1 x 5 = 5 marks) 

i.  b) Test   CBSE Study Material 1 7 1 

ii.  b) False CBSE Study Material 5 48 1 

iii.  a) Incorporating ergonomic furniture, 
soundproofing, and adjustable lighting   

CBSE Study Material 2 17 1 

iv.  a) Researching materials and prototyping 
solutions that minimize waste. 

CBSE Study Material 3 26 1 

v.  c) Develop stage CBSE Study Material 8 55 1 

vi.  b) Ideate CBSE Study Material 4 35 1 

Q. 3 Answer any 5 out of the given 6 questions (1 x 5 = 5 marks) 
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i.  a) Hear, Create, Deliver CBSE Study Material 1 7 1 

ii.  a) Understand - Improve – Apply CBSE Study Material 2 17 1 

iii.  a) Prototyping CBSE Study Material 6 51 1 

iv.  d) Everything to do with products that succeed. CBSE Study Material 4 35 1 

v.  a) Convergent thinking CBSE Study Material 7 53 1 

vi.  C) Both of them  8 55 1 

Q. 4 Answer any 5 out of the given 6 questions (1 x 5 = 5 marks)  

i.  b) Empathize > Define > Ideate > Prototype > 
Test 

CBSE Study Material 8 55 1 

ii.  e) a & d CBSE Study Material 3 26 1 

iii.  C) Information about courses CBSE Study Material 5 48 1 

iv.  c) It will not be comfortable for the user. CBSE Study Material 6 51 1 

v.  b) How much space is needed per person? CBSE Study Material 7 48 1 

vi.  a) To derive the power of design thinking, 
individuals, teams, and organizations must have 
a leap of faith about the existence of a solution. 

CBSE Study Material 4 35 1 

Q. 5 Answer any 5 out of the given 6 questions (1 x 5 = 5 marks)  

i.  b) False CBSE Study Material 3 26 1 

ii.  b) Experience Strategy CBSE Study Material 5 48 1 

iii.  d) All of above CBSE Study Material 6 51 1 

iv.  b) Contextual inquiry CBSE Study Material 7 53 1 

v.  b) Ideate CBSE Study Material 8 55 1 

vi.  c) Collect feedback from the testers to evaluate 
his idea. 

CBSE Study Material 4 35 1 

 

SECTION B: SUBJECTIVE TYPE QUESTIONS 
 

 
Q. 

No. 

 

QUESTION 

Source Material 
(NCERT/PSSCIVE/ 

CBSE Study 
Material) 

Unit/ 
Chap. 
No. 

Page 
no. of 
source 

material 

 

Marks 

Answer any 3 out of the given 5 questions on Employability Skills in 20 – 30 words each (2 x 3 = 6 marks) 

Q. 6 1) A Slide Master is a slide which contains information 
about the whole theme. It is the top slide which 
contains information about the background, fonts, 
colors, placeholders, etc. 

2) The Animations tab in PowerPoint contains a 
number of animations that you can apply to your 
slides. The easiest way to add one is to select a slide 
element, go to the Animations tab and select an 
animation effect from the given menu. 

3) Transitions: The difference between animations and 
transitions is that the latter loads a slide with an 
effect and the former is used to load slide elements. 

4) PowerPoint has introduced a revolutionary 
transition effect called Morph. This transition 
enables presenters to animate multiple parts of a 
slide which animate as you switch to the slide. 

   2 

Q. 7 1) It increases individual’s energy and activity.  
2) It directs an individual towards specific goals 

   2 

Q. 8 1) Strong leadership qualities. 
2) Highly self-motivated. 

   2 
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3) Strong sense of basic ethics and integrity. 
4) Willingness to fail. 
5) Serial innovators. 
6) Know what you don't know. 
7) Competitive spirit. 
8) Understand the value of a strong peer network. 

Q. 9 A long-term goal is something you want to do in the 
future. Long-term goals are important for a 
successful career. A long-term goal is something you 
want to accomplish in the future. Long-term goals 
require time and planning. They are not something 
you can do this week or even this year. 

   2 

Q. 10 1) On the Home tab, under Insert, click Text. 
2) On the pop-up menu, click Text Box. 
3) On the slide, click the location where you want to 

add the text box. 
4) Type or paste your text in the text box. 

   2 

Answer any 4 out of the given 6 questions in 20 – 30 words each (2 x 4 = 8 marks) 

Q. 11 A capstone project is a project where students must 
research a topic independently to find a deep 
understanding of the subject matter. It gives an 
opportunity for the student to integrate all their 
knowledge and demonstrate it through a 
comprehensive project. 

CBSE Study 
Material 

5 43 2 

Q. 12 A journey map is a diagram or other visual 
representation of the process an individual goes 
through to complete a goal. This tool can be helpful to 
identify barriers or process inefficiencies in consumer 
purchasing. 

CBSE Study 
Material 

4 36 2 

Q. 13 In the initial stages, you should start with low-fidelity 
prototypes. These could include paper sketches, 
cardboard models, or basic digital wireframes. The 
focus is on quickly exploring and testing ideas without 
investing heavily in high-cost materials or detailed 
designs. 

CBSE Study 
Material 

7 53 2 

Q. 14 Design thinking is a human-centric approach in which 
problems are defined and resolved by empathizing with 
users, understanding how problems affect them, 
generating ideas, creating prototypes, and testing them 
on the intended end users. Within project 
management, it can facilitate greater creativity and 
innovation. 

CBSE Study 
Material 

8 55 2 

Q. 15 1) COMPETITIVE ANALYSIS: Know your competitors! What 
else is out there? What is working? What isn’t? What 
features do the competitors have that our users will 
expect? What features are missing in the marketplace? 

2) MAP POSITIONNING: These tools help you to determine 
your market positioning strategy in comparison to your 
competitor strategy. 

CBSE Study 
Material 

3 26 2 

Q. 16 Brainstorming is a way to generate lots of ideas to solve 
a problem, find opportunities for improvement and 
spark innovation. 
Principles of brainstorming 
I: Generate as many ideas as possible. 

CBSE Study 
Material 

6 51 2 
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Quantity of ideas is favored over quality. Encourage 
people to keep thinking of ideas during the session. 
II: Equal opportunity to participate. 
By having each person give one idea at a time as you go 
around ensures equal participation. If someone has no 
further ideas, they can say pass but can continue to 
contribute when it comes to their turn again. 
III: Freewheeling is encouraged. 
The only bad ideas are those that are withheld. You 
must encourage everyone to share whatever comes to 
mind. This is how some of the best ideas get generated. 
IV: No criticism is allowed. 
Neither positive or negative criticism is allowed during 
brainstorming as it could cause people to hold back, 
especially when you have different levels of leadership 
in the session. 
V: Record all ideas. 
Appoint a scribe, someone to write down the ideas on a 
flip chart. Use paper so the list can be left in view or 
posted to the wall. Once again, no criticism or 
editorializing is permitted. 
VI: Let the ideas incubate. 
Don’t rush into analysis or other problem-solving 
techniques. Leave the list on display so people can 
reflect on it and new ideas might be generated or 
suggestions for combining items. 

Answer any 3 out of the given 6 questions in 50– 80 words each (4 x 3 = 12 marks) 

Q. 17 1. Simple Coconut Shell Plant Pot 
The first, easiest and simplest idea to consider is simply 
using half coconut shells as plant pots. 
These can look attractive, and allow you to avoid the use 
of plastic plant pots in your home or garden. The shell is 
fully biodegradable. Simply make a few holes in the 
bottom of each one for drainage, then place these in 
your garden or in another shell half to catch water if 
growing indoors.  
Coconut shell plant pots are ideal for seedlings to be 
potted on, and can also make attractive holders for 
microgreens, succulents, smaller herbs or perhaps even 
air plants indoors. 
 

 

CBSE Study 
Material 

2 17 4 
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 2. Bird Feeder 
You can also use a coconut shell half to make a simple 
bird feeder for your garden. Simply make holes in the 
half shell so you can hang it somewhere suitable for 
feeding wild garden birds, then fill it with a mixture of 
lard, bird seeds and other foods birds will enjoy. 

 
 

Q. 18 A mind map helps the team visually organize all possible 
ideas and features, starting from core aspects like 
battery life, design, and comfort to advanced ones like 
stress tracking and device integration. By branching out 
these features into sub-categories (e.g., comfort could 
include material, fit, and weight), the team can address 
multiple considerations simultaneously. 

Mind maps also allow for the easy identification of 
dependencies, such as how battery life may affect the 
choice of features like GPS or continuous heart rate 
monitoring. These connections help in identifying trade-
offs and prioritizing which features are most important. 

1. In the design thinking process, the first phase is 
empathy, which the mind map helps with by including 
insights from users regarding comfort and functionality. 
This user-centric approach ensures that every feature is 
aligned with user needs. 

2. Moving to define, the mind map helps the team 
clearly outline the main challenges, such as balancing 
health-tracking accuracy with battery life. The team can 
then ideate around those challenges using mind 
mapping, ensuring solutions are both creative and 
feasible. 

3. Prototyping and testing follow, where features 
identified through the mind map can be developed into 
low-fidelity models and tested iteratively, ensuring the 
smartwatch meets user expectations before a full-scale 
launch. 

Overall, mind mapping serves as a visual blueprint for 
innovation, while design thinking ensures the features 
are developed in a way that is both user-centered and 
technologically feasible. 

 

 

CBSE Study 
Material 

4 39 4 
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Q. 19 Five key steps make up the design thinking 
methodology: empathy, define, ideate, prototype, and 
test. 
 

Stage 1: Empathy 
The first stage of the design thinking process is empathy. 
During this stage, design teams set aside their own 
biases and work to gain a deeper understanding of real 
users and their needs—often through direct 
observation and engagement. 
 

 
 

Example: Imagine you are the owner of a boutique gym, 
and you want to improve membership retention. In the 
empathy phase, you would talk to a range of current and 
past members. You would solicit feedback on what they 
liked or disliked. You might observe how different 
members interacted with the equipment or different 
facilities. You would look for areas of encouragement or 
discouragement: what makes them happy? What seems 
to frustrate them? You would keep at these 
observations until you could truly understand and 
empathize with your members and their needs. 
 

Stage 2: Define 
The second step is to define the problem. In this phase, 
designers analyze the data gathered during the previous 
stage to identify and define the issue with a clear and 
concise problem statement. 
 

 
 Example: Let’s continue to use the gym scenario 
mentioned above. During the define stage, we’ll take all 
our user feedback and observational data and analyze it 
to determine why some members keep their 
membership and others don’t. We look for common 
complaints and try to identify possible pain points or 
unmet user needs. Based on our analysis, we create a 

CBSE Study 
Material 

6 51 4 
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problem statement that defines the issue that has the 
greatest impact on member retention. 
 

Stage 3: Ideate 
The ideation stage is where designers start to explore 
solutions. Ideas in this stage will ultimately become 
prototypes that can be tested with your target 
audience. 
 

 
 

Example: Based on user feedback, you were able to 
identify the number-one issue keeping members from 
renewing their membership is that there aren’t enough 
open exercise machines. During the ideate phase, you 
gather your team together and brainstorm ideas. 
Nothing is off the table. Any idea to resolve this issue is 
worth considering. 
 

Stage 4: Prototype 
During this phase of design thinking, teams will create 
prototypes of the ideas they generated in the previous 
stage. Prototypes don’t need to be finished products. 
They are meant to convey a possible solution, not 
deliver it. Sketches, models, and digital renders are all 
examples of prototypes: scaled-down versions of the 
product created during the ideation stage. 
 

 
Examples: Believing that neighboring pieces of 
equipment are being used simultaneously by users 
performing “super sets,” your idea is to relocate those 
machines to opposite sides of the gym. This should 
prohibit users from occupying multiple machines at 
once. Your first prototype is a rough sketch of what the 
new floor layout would be and where the machines 
would go. Based on feedback from staff members, you 
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prototype it again as many times as necessary. 
 

Stage 5: Test 
The testing phase of the design thinking process 
involves real users and real user feedback. During this 
phase, prototypes are given to participants to try out. 
Design teams observe how participants interact with 
the prototype and gather feedback about the 
experience.  
 

 
Example: Rearrange the exercise machines and see how 
customers respond. Does the new arrangement solve 
the users’ problem? Does it create new issues for 
different users? Solicit feedback from gym members: 
are they happy with the new arrangement? Based on 
user feedback, revisit the design thinking stages as 
necessary. 
 

Q. 20 The testing phase of the design thinking process 
involves real users and real user feedback. During this 
phase, prototypes are given to participants to try out. 
Design teams observe how participants interact with 
the prototype and gather feedback about the 
experience.   
 

Testing reveals what is or isn’t working. Don’t forget: 
design thinking is an iterative and non-linear process—
that goes for testing, too. Depending on user feedback, 
changes to the product might be required. These 
changes might require you to restart the testing phase 
or revisit past stages. Feedback from user testing might 
also inspire new potential solutions or actionable 
insights. 
 

Commonly used testing tools include: 
 

Usability Testing: A testing tool that gauges the usability 
of a design with a group of target users. 
Beta Launch: Releasing your prototype to a limited pool 
of users to determine usability, detect bugs, and test 
whether your product addresses users’ needs. 
 

CBSE Study 
Material 

7 53 4 

Q. 21  Design thinking is a problem-solving approach that can 
be incredibly useful when designing focused tablets for 
school pupils. Here are the general steps of design 
thinking, tailored to your specific scenario: 
1. Empathize: 
Understand the Users: Talk to teachers, students, and 
parents to understand their needs, challenges, and 

CBSE Study 
Material 

5 45 4 
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expectations regarding educational tablets. 
Observe: Spend time in classrooms to observe how 
students and teachers interact with technology and 
identify pain points. 
2. Define: 
Define the Problem: Based on your research, clearly 
define the challenges and issues faced by students and 
teachers regarding tablets in the classroom. 
Develop Insights: Identify patterns in the data collected 
during the empathize phase. What are the common 
problems? What are the key needs? 
3. Ideate: 
Brainstorm Solutions: Gather a diverse team and 
brainstorm potential solutions. Encourage wild and 
creative ideas without any criticism. 
Prototype Ideas: Create rough prototypes or mock-ups 
of the focused tablets. These could be simple sketches 
or digital prototypes to visualize the concepts. 
 

4. Prototype: 
Build Prototypes: Develop functional prototypes of the 
tablets based on the most promising ideas generated 
during the ideation phase. 
Iterate: Test the prototypes with a small group of 
students and teachers. Gather feedback and iterate on 
the design to improve functionality and user 
experience. 
5. Test: 
Gather Feedback: Distribute the prototypes to a larger 
group of users within the school. Collect feedback on 
the usability, performance, and overall experience. 
Refine the Design: Use the feedback to make necessary 
changes and refinements to the tablet design. This 
might involve hardware adjustments, software updates, 
or user interface enhancements. 
6. Implement: 
Production: Once the design is finalized, move into full-
scale production of the tablets. 
Training: Provide training sessions for teachers and 
students on how to effectively use the tablets for 
educational purposes. 
7. Evaluate: 
Assess Impact: Monitor the use of tablets in classrooms. 
Gather data on academic performance, engagement 
levels, and any other relevant metrics to evaluate the 
impact of the focused tablets. 
Collect Long-term Feedback: Continuously collect 
feedback from teachers, students, and parents to make 
ongoing improvements to the tablets based on their 
real-world usage. 
8. Iterate: 
Continuous Improvement: Use the feedback and data 
collected to make iterative improvements to the 
tablets. Technology and educational needs evolve, so 
the design should be flexible and adaptable. 
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Q. 22 Every aspect of a design thinking plan is created with 
customers in mind. Design thinkers develop a product 
that appeals to the customers because with the help 
of automated tools. Here are some of the standard 
tools used across various stages of design thinking: 
 

1) Analysis and synthesis: It helps consolidate data 
collected through various sources, also assisting in 
converting data into actionable results. There are 
many tools for visualization, assumption testing, 
and others. 

2) Ideation: There are many tools that design 
thinkers use for facilitating brainstorming or 
ideation sessions, such as rapid concept 
development, mind mapping, storytelling, etc. 

3) Prototyping: Tools like rapid prototyping, journey 
mapping, etc., are used by design thinkers during 
prototyping to test the product or service’s 
usability and the experience it creates. 

4) Immersion: There are many tools that design 
thinkers use to determine the customer’s problem 
and offer solutions to it. 

CBSE Study 
Material 

8 55 4 

 


